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TO REDUCE THE RISK OF FIRE AND ELECTRIC SHOCK, DO NOT EXPOSE THIS UNIT TO RAIN OR 
MOISTURE.

IMPORTANT SAFEGUARDS

Read and Follow Instructions- All the safety and operation instructions 
should be read before the video product is operated. Follow all 
operating instructions.

Retain Instructions- The safety and operating instructions should be 
retained for future reference.

Heed all Warnings-Comply with all warnings on the video product and in 
the operating instructions.

Polarization- Some video products are equipped with a polarized 
alternating -current line plug. This plug will fit into the power outlet, try 
reversing the plug. If the plug still fails to fit, contact your electrician to 
replace your obsolete outlet. To prevent electric shock, do not use this 
polarized plug with an extension cord, receptacle, or other outlet unless 
the blades can be fully inserted without blade exposure. If you need an 
extension cord, use a polarized cord.

Power Sources- This video product should be operated only from the 
type of power source indicated on the marking label. If you are not sure 
of the type of  power supply to your home, consult your video dealer or 
local power company. For video products intended to operate from 
battery power, or other sources, refer to the operating instructions.

Overloading- Do not overload wall outlets or extension cords as this can 
result in a risk of fire or electric shock. Overloaded AC outlets, extension 
cords, frayed power cords, damaged or cracked wire insulation, and 
broken plugs are dangerous, They may result in a shock or fire hazard. 
Periodically examine the cord, and if its appearance indicated damage or 
deteriorated insulation, have it replaced by your service technician.

Power-Cord Protection- Power-supply cords should be routed so that 
they are not likely  to be walked on or pinched by items placed upon or 
against them, paying particular attention to cords at plugs, convenience 
receptacles, and the point where they exit from the video product.

Ventilation- Slots and openings in the case are provided for ventilation 
to ensure reliable operation of the video product and to protect it from 
overheating. These openings must not the blocked or covered. The 
openings should never be blocked by placing the video product on a bed, 
sofa, rug, or heat register. This video product should not be placed in a 
built-in installation such as a book case or rack, unless proper ventilation 
is provided or the video product manufacturer's instructions have been 
followed.

Attachments- Do not use attachments unless recommended by the video 
product manufacturer as they may cause hazards.

 For easy installation, please put the socket  in the place where is 
convenient for the plug in and out.

                                              : To reduce the 
                                                     risk of fire and electric shock, do 
                                                     not remove the cover (or back) of 
 the unit. Refer servicing only to qualified service personnel.

The lightning flash with arrowhead symbol, within an equilateral 
triangle, is intended to alert the user to the presence of uninsulated 
"dangerous voltage" within product's enclosure that may be of 
sufficient magnitude to constitute a risk of electric shock.

The exclamation point within an equilateral triangle is intended to 
alert the user to the presence of important operation and servicing 
instructions in the literature accompanying the appliance.

WARNING: TO REDUCE THE RISK OF FIRE OR ELECTRIC SHOCK, DO 
NOT EXPOSE THIS APPLIANCE TO RAIN OR MOISTURE.

CAUTION: TO PREVENT ELECTRIC SHOCK, MATCH WIDE BLADE OF 
PLUG TO WIDE SLOT AND FULLY INSERT.

In addition to the careful attention devoted to quality standards 
in the manufacture of your video product, safety is a major factor 
in the design of every instrument. However, safety is your 
responsibility, too. This sheet lists important information that will 
help to assure your enjoyment and proper use of the video 
product and accessory equipment. Please read them carefully 
before operation and using your video product.

Installation

Water and Moisture- do not use this video product near water for example, near a 
bath tub, wash bowl,  kitchen sink or laundry  tub, in a wet basement, or near a 
swimming pool and the like. Caution: Maintain electrical safety. Powerline operated 
equipment or accessories connected to this unit should bear safety certification 
mark on the accessory itself and should not be modified so as to defeat the safety 
features. This will help avoid any and should not be modified so as to defeat the 
safety features. This will help avoid any potential hazard from electrical shock or fire. 
If in doubt, contact qualified service personnel.

Accessories- Do not place this video product on an unstable cart, stand, tripod, 
bracket, or table. The video product may fall, causing serious injury to a child or 
adult as well as serious damage to the video product. Use this video product only 
with a cart, stand, tripod, bracket, or table recommended by the manufacturer's or 
sold with the video product. Any mounting of the product should follow the 
manufacturer's instructions and use of a mounting accessory recommended by the 
manufacturer.

A video product and cart combination should be moved with care. Quick stops, 
excessive force, and uneven surfaces may cause the video product and cart 
combination to overturn.
Note to CATV system installer
This reminder is provided to call the CATV system installer's attention to 
Section 820-40 of the NEC which provides guidelines for proper grounding 
and, in particular, specifies that the cable ground shall be connected to the 
grounding system of the building, as close to the point of cable entry as 
practical.

Outdoor Antenna Grounding- If an outside antenna or cable system is connected to 
the video product, be sure the antenna or cable system is grounded so as to provide 
some protection against voltage surges and built-up static charges. Section 810 of 
the National Electrical Code, ANSI/NFPA No.70-1984 (Section 54 of Canadian 
Electrical Code, Part1) provides information with respect to proper grounding of 
the mast and supporting structure, grounding of the lead-in wire to an antenna-
discharge unit, connection to grounding electrodes, and requirements for the 
grounding electrode.

Power Lines-An outside antenna system should not be located in the vicinity of 
overhead power lines, other electric light or power circuits, or where it can fall into 
such power lines or circuits. When installing an outside antenna system, extreme 
care should be taken to keep from touching or approaching such power lines or 
circuits, as contact with them might be fatal. Installing an outdoor antenna can be 
hazardous and should be left to a professional antenna installer.

Use
Cleaning- Unplug this video product from the wall outlet before cleaning.
Do not use liquid cleaners or aerosol cleaners. Use a damp cloth for cleaning.

Objects that may touch dangerous voltage points or "short-out" parts could result in 
a fire or electric shock. Never spill liquid of any kind on the video product.

Lightning-For added protection for this video product during a lightning storm, or 
when it is left unattended and unused for long periods of time, unplug it from the 
wall outlet and disconnect the antenna or cable system. This will prevent damage to 
the video product due to lightning and power line surges.

Service
Servicing-Do not attempt to service this video product yourself, as opening or 
removing covers may expose you to dangerous voltage or other hazards. Refer all 
servicing to qualified service personnel.

Conditions Requiring Service-Unplug this video product from the wall outlet and 
refer servicing to qualified service personnel under the following conditions: 
A. When the power-supply cord or plug is damaged.
B. If liquid has been spilled, or objects have fallen into the video product.
C. If the video product has been exposed to rain or water.
D. If the video does not operate normally by following the operating 

instructions. 
      Adjust only those controls that are covered by operating instructions. 

Improper adjustment of other controls may result in damage and will often 
require extensive work by a qualified technician to restore the video product 
to its normal operation.

E. If the video product has been dropped or cabinet has been damaged.
F. When the video product exhibits a distinct change in performance-this 

indicates a need for service.

Replacement Parts-When replacement parts are required, have the service 
technician verify that the replacements he uses have the same safety 
characteristics  as the original parts. Use of replacements specified by the video 
product manufacturer can prevent fire, electric shock, or other hazards.

Safety Check-Upon completion of any service or repairs to this video product, ask 
the service technician to perform safety checks recommended by the manufacturer 
to determine that the video product is in safe operating condition.

Wall or Ceiling Mounting- The product should be mounted to a wall or ceiling only 
as recommended by the manufacturer.

Heat-The product should be situated away from heat sources such as radiators, 
heat registers, stoves, or other products (including amplifiers) that products heat.
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CAUTION

The apparatus shall not be exposed to dripping or splashing, and that no 
objects filled with liquids, such as vases, shall be place on the apparatus.

SAFETY INFORMATION
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RF IN RF OUT 

Pr

CVBS R L

Y Pb

HDMI
Coaxial 

AC 220-240V
  ~50/60HZ

Front panel

Rear panel

INTRODUCTION

Remote sensor

AC Mains

Composite Video

Coaxial Digital Audio

TV aerial 
for an external TV aerial 

RF Loop through 
for an external device

HDMI Output
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USB port

Standby button

Down Mix Audio
2 Channel L/R

Display

Progressive Scan Video 
(Y Pb Pr)

Channel up Channel Down
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INFO SUBTITLE

OK

EPG

AUDIOUSB TV/RADIO
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CH-

TTX TIMER FAV

MUTE

MEDIA

RES 
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STANDBY
(switch the STB on  and standby)

INFO
(Press for current channel information )

PLAY

26

OK button
(Confirm a selection within a menu)

Numeric entry
(Enter numeric values and select the channel 
directly by entering it's number)

AUDIO
(Select audio mode and audio track) 

SUBTITLE (On/Off Subtitle) 

TTX  (Open interactive service)

8

9

11

10

12

13

15

14

4

5
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7

16

17

18

19

20

21

22

23

24

25

BACK
(Switch to previous channel)

EPG
(Open up Electronic Program Guide Menu) 

Cursor/CH+, -/VOL+,-
(Cursor: Navigation buttons used to navigate
menu's items)
(CH+/-: Channel Up and Down)
(VOL+/-: Volume Up and Down)

RECORD
(Record the TV program)

Search backward /forward

FAV
(Open the Favorite list)

RED/GREEN/YELLOW/BLUE Buttons
(For interactive function/Submenu 
 function buttons)

PAUSE(Pause/Active timeshift function)

Previous/Next

STOP
(Stop program playback or recording)

TV/RADIO
(Switch between TV and Radio)

MUTE (Turn off/on the volume)

MEDIA
(Enter Record menu)

USB
(Enter Music menu)

TIMER
(Timer wake-up)

Menu
(Open and close the menu screen)

EXIT (Exit from menu)

RES (Switch HDMI resolution)
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SYSTEM CONNECTION

There are many different types of TV and other equipment that you can connect to the STB.
In this manual you will see some of the most common ways to connect your equipment.

General

Connecting a HiFi system

Coaxial cable

Connecting the TV
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Hi-Fi

HDMI TV 

RF  cable

   Audio 
(Down mix stereo)

HDMI cable Component Video

   Video (Composite)



Welcome

If you use the STB for the first time, the "Welcome" menu appears.

Press cursor button to setup the Region, Language, Display Mode 

and Aspect Mode.

Highlight "OK" and press the "OK" button to start channel search.

GETTING STARTED

Installation

Select "Channel Scan", press the "OK" button to enter the Channel 
Scan menu. 
Press cursor button to set Scan mode, Scan Band ,
Channel No., Frequency and Bandwidth, then highlight "Search",  
press "OK" button to start channel scan . 

1

1

2

2

4

Press the cursor button to set "FTA Only", then highlight "Search", 
press the "OK" button to start auto scan .

1

2

3

Channel Scan mode: 
By channel
By frequency

Select the "Aerial Adjustment", press"OK" to enter the Aerial 
Adjustment.

Press the cursor button to set the desired setting. 
When "Tuner Power" is selected "On", the STB will provide 5V power 
to antenna.
It will not provide when selected "Off".     

1

2
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Welcome

Region
Language

Display Mode
Aspect Mode

Poland
English

576i
Auto

OK

Auto Scan

Channel Scan

Aerial Adjustment

LCN

Press the "MENU" button to enter main menu.

Press "UP"or " DOWN " button to highlight "Installation", press 

"RIGHT" button to enter the Installation menu.

Press "UP" or "DOWN" cursor button to highlight the desired item 

and press "OK"button to enter the sub-menu .

Press "EXIT" button to exit.

Select the "Auto Scan", press "OK" button to enter the Auto Scan menu.

If  LCN( Logical Channel Number) Select function is activated, you can't change the original 
number of TV channels by scanning . 
You can activate/disactivate the LCN function by setting the "LCN Mode" to on/off.

Auto Scan
Channel Scan
Aerial Adjustment
LCN

Installation

Auto Scan

FTA Only
Search

No

Channel Scan

Scan Mode
Scan Band
Ch No.

Search

Frequency
Bandwidth

By channel
UHF

CH37(666000KHz)
666000KHz

8MHz

Signal Intensity
Signal Quality

81%
97%

Aerial Adjustment

Ch No.
Tuner Power

CH37(666000KHz)
Off

Signal Intensity
Signal Quality

81%
97%



Accessing the Electronic Program Guide (EPG)

OPERATION

Changing Channels 

There are three ways of channel selection - stepping through the channel list, selection by number 
and from the on-screen channel list.

Stepping through the channel list:
            To move through the channel list, press the upward  arrow or downward arrow key on the 
            remote control.

Selected by number: 
            Enter the channel number directly by pressing numeric buttons ,and press the "OK" button 
            to select desired channel.
               Selected by on-screen channels list:
            You can also select the required channel directly from on-screen channel list. This is 
            displayed using the STB's main menu. See "Edit Channel" in this manual for operation detail.

1

2

3

Accessing the EPG of all channels: 

1

2

3

Press "EPG" button to enter EPG menu .

Press cursor button to switch between channel list, events 
schedule of the selected channel and now/next events.

Press "Green" button to Timer the events.

Press "Red" button to display " Time Bar" menu.4

1 English5

0008
0009
0010
0011
0012

Interecon
BBC Parl
BBC FO
CBeebie
301

0010 BBC FOUR

The Recor

This is CBeebies!
Auntie's War on Smut

The RecorCommons Questions
Proms on FOUR

Auntie's War on Smut
01:30-02-30

TimerTime

EPG

3/19 01:30 02:00 02:30 03:00

01:39   xx/xx/xxxx



Edit Channel menu 

EDIT CHANNEL

TV Channel list

In the Edit Channel menu, select "TV Channel List", press "OK" 
button to enter TV channel list menu.

1

2

Use this menu to favor, lock, skip, move, sort, delete and  rename 
channel.

Press "FAV" button, then press "OK" button to edit the FAV 
function.

Press "UP" or "DOWN"  button  to highlight channel, press the "OK" 
button to preview the desired TV channel. 

1 English6

4

1

2

3

Press the "MENU" button to enter main menu.

Press "UP" or "DOWN " button to highlight "Edit Channel", press 

"RIGHT" button to enter the Edit Channel menu.

Press "UP" or "DOWN" cursor button  to highlight the desired item 

and press "OK" button to enter the sub-menu .

Press "EXIT" button to exit.

Sort

YooPlay Ga
xxxxxxxx
xxxxxx
xxxx
xxx

TV Channel List

FAV Lock Skip Move Edit

All Channel

0001 No Name
0002 YooPlay Ga
0003 E4+1
0004 UKTV Histor
0005 SKY THREE
0006 Sky Spts Ne
0007 Sky News

0001 No Name
0002 YooPlay Ga
0003 E4+1
0004 UKTV Histor
0005 SKY THREE
0006 Sky Spts Ne
0007 Sky News

i

Radio Channel list 

In the Edit Channel menu, select "Radio Channel List", press "OK" button to enter the Radio 
Channel list menu.
Press "UP" or "DOWN" button to highlight channel press the "OK" button to listen the desired TV 
channel. 

1

2

NOTE:             Basically, the operation of "Radio Channel List" is the same as "TV Channel List", 
but there is one point  different: In "Radio Channel List" mode, there is no video 
information, so it will always display Radio's logo in the right side preview window.

Delete All

1

2 A warning window appears.
Select "Yes", press "OK" button to delete all channels.
Select "No", Press "OK" button to cancel deleting.

Warning! Do you really want to delete 
all channels?

Yes No

In the Edit Channel menu, select "Delete All", press "OK" button.

Press "color" button, then press "OK" button to edit the 
corresponding function.

TV Channel List
Radio Channel List
Delete All

Edit Channel

Rename Delete

YooPlay Ga
xxxxxxxx
xxxxxx
xxxx
xxx

Edit Channel

All Channel

i



System setup menu 

System setup menu allows us to set Language, TV System, Local Time 
Setting, Timer Setting, Parental Lock, OSD Setting, Favorite and Auto
Standby. 

Language 

This menu allows you to set  Language.

SYSTEM SETUP

TV System

This menu allows us to set Video Resolution, Aspect Mode, 
Video Output and Digital Audio Output.

Local Time Setting

This menu allows you to set the region and time.

GMT Usage:  This menu is used  for  open the usage of GMT. 
The options are : Off / On

GMT Offset:  This menu  is valid only when selected "User Define" 
in GMT Usage menu . 
The GMT offset range is "-11:30 ~ +12:00", increasing 
half hour progressively.

Date:
Time:

"Date" and "Time" menus are  valid only when selected "Off" in GMT Usage menu.
Press numeric button to input the time.

Region:  This menu is used for changing the region setting.

Aspect Mode:  Auto/4:3PS/4:3LB/16:9

Video Output:  

Digital Audio Output:  

HDMI/RGB

Video Resolution:

LPCM Out/ BS Out/ Dolby

576i/576p/720p/1080i/1080p

1 English7

Video Resolution
Aspect Mode
Video Output
Digital Audio Output

576i
Auto
RGB

LPCM Out

TV System

Region
GMT Usage
GMT Offset
Summer Time
Date
Time

France
On

GMT+01:00
Off

xxxx/xx/xx
01:51

Local Time Setting 

xxxx,xxx,xxxx

4

1

2

3

Press the "MENU" button to enter main menu.
Press "UP" or "DOWN" button to highlight "System Setup", 
press "RIGHT" button to enter the System Setup menu.
Press "UP" or "DOWN" cursor button  to highlight the desired 
item and press "OK" button to enter the sub-menu.
Press "EXIT" button to exit.

Language
First Audio
Second Audio
Subtitle Language 
Subtitle Display 
Teletext 

English
English
German
English

Off 
English

Language

Timer Setting

This menu  allows us to set the program timer. You can set 8 timers.

Timer Mode:
Timer Service:
Wakeup Channel:
Wakeup Date:
Wakeup Time:
Duration: 

Off/Once/Daily/Working day/Weekly
Channel/Record
You can select a desired channel as the wakeup channel.
Press numeric button to input date.
Press numeric button to input the time.
Press numeric button to input the duration time.

Save Cancel

Current Time/date: 01:36PM   xx/xx/xxxx

Timer Mode
Timer Service
Wakeup Channel
Wakeup Date
Wakeup Time
Duration

Daily
Channel

BBC FOUR
xx/xx/xxxx

xx:xx
xx:xx

System Setup

Language
TV System
Local Time Setting
Timer Setting
Parental Lock
OSD Setting
Favorite
Auto Standby



OSD Setting

This menu allows you to set OSD Timeout and OSD Transparency .

This menu allows you to rename the favorite group.

OSD Timeout: 1-10

OSD Transparency:  To set the OSD transparency to Off/10%/20%/30%/
40%.

SYSTEM SETUP

Parental Lock

In "System Setup" menu, select "Parental Lock" and press "OK" button,
you are asked to input a password(the default password is"0000").
After inputting the correct password by pressing numeric buttons, 
the parental lock menu appears.

1

2

Menu Lock:  

New Password:  To change the password.

Confirm Password:  To confirm the new password.

Channel Lock: Off/ AGE 10/AGE 12/AGE 16/AGE 18

1 English8

To lock the Edit channel/ installation/System setup/ Tools/
REC menu. When you  want to enter these menus, you must 
input the password. You can set menu lock to on/off.

This menu allows you to protect  menu and channel, and change the 
Password.

Favorite

In Channel menu, select "Favorite", press "OK" button to enter 
Favorite menu.
Select desired group, press "OK" button to open the mock keypad.
Input letter and numeric one by one by pressing the cursor button 
and press "OK" button to confirm. After finishing input, highlight 
"OK" on mock keypad to confirm, you change Favorite group name 
successfully.
Press "EXIT" button to quit the group rename menu.

1

2

3

Auto Standby

No command to STB on front panel or Remoter in 3 hours and 
no timer event, the STB will enter standby mode automatically.

The STB can't enter standby mode automatically.

On

Off

Menu Lock
Channel Lock
New Password
Confirm Password

Off
Off
----
----

Parental Lock

OSD Timeout
OSD Transparency

5
Off

OSD Setting

1
2
3
4
5
6
7
8 

Favorite

Fav group 1
Fav group 2
Fav group 3
Fav group 4
Fav group 5
Fav group 6
Fav group 7
Fav group 8

Auto Standby On

Auto Standby

CAPS

A

Fav group 1 

G
M

S

Y

4

SP

Rename

Del OK

B C D E F
K LH JI

N

T

Z

5

O

U

0

6

?

P

V

1

7
<-

Q

W

2

8

OK

R

X

3

9



Tools main menu 

Information 

In "Tools" menu, select "Information", press "OK" button to open 
information window.

Press "EXIT" button to exit.

1

2

                 TOOLS

This menu can display some parameters  information in this STB.

Load Factory Setting

This menu allows you to re-set the STB back to factory settings, 
clear all existed channels.

In the "Tools" menu, select "Load Factory Default", press "OK" button. 
You are asked to input a password(the default password is"0000").

1

2

Software Upgrade

Press "EXIT" button to exit.

Enter "Tools" menu, select "S/W  Upgrade by OTA" or "Upgrade 
by USB", press "OK" button, Software Upgrade menu is shown.

1

2 Press cursor button to select the desired item, then highlight 
"Start" and press "OK" button to start upgrade.

3

A confirmation window is displayed.
Select "Yes" to return back to factory settings  and clear all channels.
Select "No" to cancel back to factory settings.
Press "EXIT" button to exit .

We offer the functions for user to upgrade software version by OTA 
or by USB .

1 English9

4

1

2

3

Press the "MENU" button to enter main menu.

Press "UP" or " DOWN " button to highlight "Tools", press "RIGHT" 

button to enter the Tools menu.

Press "UP" or "DOWN" cursor button  to highlight the desired item 

and press "OK" button to enter the sub-menu.

Press "EXIT" button to exit.

3

Tools
Information
Load Factory Setting
S/W Upgrade by OTA
Upgrade By USB
Remove USB device safely

Information
x.x.x
xxxxx
xxxxx
x.x.x
x.x.x

xxx
xxxxx
xxxxx
xxx
xxx

Load Factory Setting

This operation will load default and erase all
the channels that user added, the system will
reboot, continue?

Yes No

Upgrade by USB

Upgrade mode
Upgrade File
Start

Allcode
No File

0%

Remove USB device safely

In "Tools" menu, select "Remove USB device safely", 
Press "OK" button to confirm. Then a window is displayed.
Press "OK" button again.

Information
Load Factory Setting
S/W Upgrade by OTA
Upgrade By USB
Remove USB device safely

Tools

Disk Remove
Remove

OK

USB Disk A-3 GB

Cancel



Game

This menu allows you to play games.

                 GAME

4

1

2

3

Press the "MENU" button to enter main menu.

Press "UP" or "DOWN" button to highlight "Game", press "RIGHT" 

button to enter the Game menu.

Press "UP" or "DOWN" cursor button to highlight the desired item 

and press "OK" button to enter the game.

Press "EXIT" button to exit.

1 English10

Game

Othello
Sudoku



REC main menu

REC

1 English11

4

1

2

3

Press the "MENU" button to enter main menu.

Press "UP"or "DOWN" button to highlight "REC", press 

"RIGHT"  button to enter the REC menu.

Press "UP" or "DOWN" cursor button to highlight the desired item 

and press "OK"button to enter the sub-menu.

Press "EXIT" button to exit.

Media Player

3

In "REC" menu, select "Media Player", press "OK" button to enter 
Media Player menu.
First you enter media player window, the highlight is on the 
USB/HDD device. Press "Down" button  to move the highlight to 
directory and file field. 
Press "INFO" button ,you can switch TAB between 
Music/Image/Video/Record.
Press "UP" or "DOWN" cursor button to select a desired item, 
and press "OK" button to play the desired files. 
Press "EXIT" button to exit.

1

2

This function allows you to play files from USB port .     

I swear.mp3
3319KB
00:03:32

00:03:15  00:03:32

1

3
4
5
6
7

2

Music

840.mpg

Why.mp3
Lonely.mp3
Because.mp3
Rose.jpg
Fly.jpg 

I swear.mp3

USB 1

/..

Play List

Switch Repeat Sort

MPG
MP3
MP3
MP3
MP3
JPG
JPG

INFO 21

REC
Media Player
HDD Information
PVR Setting

FAV FAV All Edit

ExitEXIT

Image Video Record

Music:

Image:    

 Press  "RED" button to show Play List. 
 Move the highlight to the file which you want to add to play list, then press 
"Green" button to add. It will mark a favorite icon  on the file.
Press "Yellow" button to add all file of current directory to play list. Press  again to 
delete all file of current directory from the play list.
Press "Blue" button to enter to edit sub-menu.
Press "1" button to open the sort window. You can sort by Name/Time/Size/Favorite.
Press "2" button to set repeat mode. The option is Repeat Folder/ 
Random Folder/Repeat One.
Return to parent directory.
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Press "Red" button to show play list.
Move the highlight to the file which you want to add to play list, then press 
"Green" button to add. It will mark a favorite icon on the file.
Press "Yellow" button to add all file of current directory to play list. Press  again to 
delete all file of current directory from the play list. 
Press "Blue" button to enter to edit sub-menu. 
Press "1" button to open the sort window. You can sort by Name/Time/Size/Favorite.
Press "2" button to open image setup
Press "3" button to view image in multi view mode
Return to parent directory.

"RED" button: 
"GREEN" button:
 
"YELLOW" button: 

"BLUE" button: 
"1" button: 
"2" button: 

"EXIT" button:

"RED" button: 
"GREEN" button:
 
"YELLOW" button: 

"BLUE" button:  
"1" button: 
"2" button: 
"3" button: 
"EXIT" button:



This menu allows us to set the PVR Setting.

Press "UP" or "DOWN" cursor button to select desired item, 
press "LEFT" or "RIGHT" cursor button to change the setting.

TimeShift                                 On/Off

Timeshift to Record              On/Off

PS Record                                On/Off  

Standby after record                On/Off

PVR Setting
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REC & MEDIA

HDD Information

In "REC" menu, select "HDD Information", press "OK" 
button to open HDD information window.

Press "EXIT" button to exit.

This menu can display some parameters of Removable Disk.
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HDD Information
USB Disk A: xxxG bytes

Volume
Total Size
Free Size
Rec Size
TMS Size
File System

xxxx
xxxx
xxxx
xxxx
xxxx

xxx

Format DVR Set

Timeshift
Timeshift to Record
PS Record
Standby after record

ON 
ON 
OFF 
OFF

PVR Setting

DVR Set                 REC&TMS/Record/Timeshift

Press BLUE button to open DVR Set menu. 
Press "LEFT" or "RIGHT" cursor button to change DVR Type.
Select "OK" to confirm. Select "Cancel" to cancel.

Press YELLOW button to open Format menu.
Press "LEFT" or "RIGHT" cursor button to change Disk Mode.
Select "OK" to format. Select "Cancel" to cancel.

Format               FAT/NTFS

DVR Set
DVR Type

OK

REC& TMS

Cancel

Format
Disk Mode

OK

FAT

Cancel

Record:

Press "Red" button to  open rename window. 
Move the highlight to the program which you want to lock. Pressing "Green" 
button, it will ask you to input password. Default password is "0000". After 
input correct password, the program  is locked. If you want to unlock the 
program, press the "Green" button again.
Press "Yellow" button to make a delete mark on the program which 
you want to delete.
Return to parent directory.

Video:

Press "Blue" button to enter to edit sub-menu.
Press "1" button  to open the sort. You can sort by Name/Time/Size.
Return to parent directory.

"BLUE" button:  
"1" button: 
"EXIT" button:

"RED" button: 
"GREEN" button:
 

"YELLOW" button: 

"EXIT" button:



TIMESHIFT/RECORD

Timeshift

Plugging an external Mass Storage Device on the USB port gives you access to Time Shift/Record 
a broadcast programme.

Pause a broadcast programme  and continue watching it later (Time Shift )
Record a broadcast programme.
When the space available on the Mass Storage Device runs out, recording operation of 
broadcast will stop.

Initiate

Trickmodes

Stop the Time Shift

Time Shift can be done in viewing mode by pressing the  
"PAUSE" button.
Press "RIGHT" or "LEFT" button to move the cursor to
the time you desired to view. Press "OK" button to confirm.

During the playback, it is possible to perform the following actions :
Press "PAUSE" button to pause the playback
Press "FORWARD" button to fast forward the playback
Press "BACKWARD" button to rewind the playback

Record

Instant record

In viewing mode, press "RECORD" button to instantaneously start a record on the current channel.
Press "RECORD" button again can input duration.
Press "STOP" button to stop recording, then a confirmation window appears. 
Select "Yes" to stop recording. Select "No" to continue recording.

Press "STOP" button to stop TimeShift.

BBC FOUR

Play    00:02:37 00:07:12

TS

2%

03/19 01:36
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NOTE:

Please use USB 2.0 disk when recording or timeshift.
For timeshift and recording feature, you need take bigger size USB pen
driver or HDD (>2GB) for recording.

Two Programs Recording in the same TP( Transponder)

When recording 2 FTA programs in the same transponder user can change to 
any programs via CH+/-  button. 
In order to indicate the information of the recording programs, there is a REC 
icon on the screen if the program is recording. 
Press  "STOP " button to stop recording, then a confirmation window appears. 

Select Rec1/Rec2 to stop recording Rec1/Rec2. Select "Cancel" to continue recording.

Rec 2 Cancel

Stop recording?

Rec 1: [SZTVM01] 

Rec 2: [SZTVM04]

Rec 1
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TIMESHIFT/ RECORD

Please select famous brand USB 2.0 USB HDD or USB stick for Recording and Timeshift, such as SAMSUNG, 
HITACHI  and SONY. Some USB devices maybe can't be supported due to its quality.

NOTE:

Two Programs Recording in Difference TP

When recording 2 FTA programs in difference TP, user can tune to FTA programs in the two TP. 
In the channel list, the programs outside of the TP are grayed and can not be selected. 



In some region, the digital terrestrial signal may be weak. So you'd better use the antenna in 
which the booster was built, for watching the weak signal channels.

TROUBLESHOOTING

Problem

Standby light not lit

No signal found

No picture or sound

Scrambled channel 
message

No response to remote 
control

Forgotten channel lock 
code

Forgotten menu lock 
code

The remote control will 
not operate your STB

After moving the STB to 
another room you find you 
are no longer able to
receive digital reception 

Possible cause What to do

Mains lead unplugged 
Mains fuse blown

Aerial is disconnected 
Aerial is damaged/misaligned
Out of digital signal area

Scart/AV is not selected on your TV

Channel is scrambled 

Receiver off
Handset not aimed correctly
Front panel obstructed 
Hand set batteries exhausted

(1) The batteries in your remote 
     control need replacing 
(2) There is an obstruction 
     blocking the signal path 
     between the remote control
     and the box. 

The aerial feed former new point
may come through a distribution 
system which may reduce the 
digital signal now received by the
box.

Check mains lead 
Check fuse 

Check aerial lead
Check aerial 
Check with dealer 

Reduce to another channel 

Select alternative channel

Plug in and turn on plug
Aim handset at front panel 
Check for obstructions
Replace handset batteries 

Re-install channels to cancel 
channel lock 

Contact help line

(1) Replace the batteries 
(2) Check that there is nothing in 
      the way of the path between
      the remote control and the 
      receiver

Try a direct feed from the antenna 
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